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Safety

CAUTION: Do not move the fully assembled unit. Use both hands when lifting or moving any part 
of the system. Carry each part from the bottom.

Cleaning the System
Clean the outer surfaces of the system by wiping them with a damp cloth and common laboratory 
cleaner.

System Ventilation
For adequate ventilation of this equipment, a distance of 15cm must be kept from this unit and any 
other surfaces.

Electrical Safety

Use proper plugs and good earth ground connections. 

For systems operating at voltages other then 115 volts AC or 220 volts AC, a 
locally approved 3-prong plug may be required to correctly power the system.

Wiring Specifications

Live (L) Brown lead

Neutral (N) Blue lead

Earth (E) Green/yellow lead

WARNING

WARNING



Explanation of Symbols

You may find one or more of the following symbols used on labels on your system.

Symbol Explanation L’explication Erklarung

Alternating Current Courant alternatift Wechselstrom

Protective Earth Ground Mise a la terre Schutz -Erdun

On (Supply) Marche (alimentation)  Ein

Off (Supply) Arret (alimentation) Aus

Caution-Attention: Risk of 
Electrical Shock

Attention Risque de choc Vorsicht Spannug 
Gefahrliche

Caution (refer to 
accompanying 
documents)

Attention: Voir les 
documents cijoints

Vorsicht Siehe 
Begleitinformation

Serial Out Sortie serie Serieller Ausgang

Printer Imprimante Drucker

Monitor Moniteur Bildschirm

Fuse Label 1 Current 
Warning

Etiquette d'advertissement 
relatif au type et au 
courant du fusible

Sicherung/Stromstarke
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Chapter 1

The System Computer
The system comes supplied with a built-in Pentium® computer. 

The system can also be attached to a network. We sell a networking kit to attach 
the system to a network. For additional information on the networking kit, contact 
your PerkinElmer representative.

Software Security
Security is built-in to QuantaSmart. The same software cannot be loaded on 
multiple systems due to this security feature.
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Chapter 2

The System Software
The QuantaSmart™ program is the Windows XP® interface for the TriCarb® 
Liquid Scintillation Analyzer series of instruments. This innovative tool allows you 
to take advantage of all the instrument features via a main software window. The 
main window uses standard Windows® conventions. It allows you to easily access 
and control all the system features and capabilities via different functional 
components. The Protocols Tree in the main window provides you with graphical 
representations of existing assay associations. The Output Report and 
SpectraView™ windows display information regarding sample data and sample 
analysis. Any assay data that is collected may be reanalyzed, without recounting 
samples using the optional Replay™ feature.

The system utilizes a set of Libraries to store standard and sample information. 
The Nuclide Library allows you the flexibility of selecting and using the same 
standards sets in any number of different assays. It also provides you with a 
convenient means of saving and reusing specific nuclide parameters and sample 
counting regions.

The Getting Started Manual
The purpose of this manual is to provide you with basic information regarding the 
QuantaSmart program. It will enable you to perform simple tasks, using many of 
the system’s default settings. For information regarding advanced features of the 
system, please refer to the online help documentation.

The Online Help
The Online Help is a comprehensive system designed to provide you with detailed 
reference and operational information for the QuantaSmart program. It should be 
considered the primary resource of information for the software.

The QuantaSmart program provides you with access to the help system via help 
buttons. By clicking these buttons, you will display the help documentation for the 
current window. Once in the help system, you can utilize the table of contents, 
index, search feature or hypertext links to access information regarding other help 
topics. You can also access these help features via the Help menu in the 
QuantaSmart main window.
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The Table of Contents
The table of contents displays main topics using a book symbol. Each book may 
contain one or more pages representing topics. Clicking on a book reveals the 
topics included in that book. Double clicking on a page displays the 
documentation for that topic.

Figure 2-1The Online Help Documentation Table of Contents.
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The Index
The index displays a comprehensive, alphabetical list of topics available in the 
online help documentation. Double clicking on any of the indexed items displays 
the documentation for that topic.

Figure 2-2The Online Help Documentation Index.
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The Search Feature
The Search (Find) feature allows you to search the online help documentation for 
a word or words. After entering the word you would like to find, a list of topics is 
provided of all the topics in the documentation where instances of the word occur. 
Double clicking on the item in the list displays the documentation for that topic. 

Note: Since every instance of a word or phrase is found by the 
Help system, duplicate entries may be displayed in the Find tab.

Figure 2-3 The Online Help Documentation Find Feature.

Assays
In the QuantaSmart program, an assay represents a comprehensive set of 
parameters that the system uses for the purpose of sample analysis. Assays are 
defined using seven Assay Definition tabs, each of which allows you to enter 
information specific to one aspect of the assay. Once an assay is defined, it may 
be saved, used or edited at your discretion. 
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Protocols
All of the assay information that you define and save becomes a functional entity 
only after it is associated to a protocol. These protocols are recognized by the 
instrument via a protocol flag. This device contains an encoded, reflective metal 
which the instrument uses to identify the protocol number and sample counting 
parameters that you have defined and elected to use. The QuantaSmart program 
enables you to define an unlimited number of assays and associate them with up 
to sixty protocols (flags). Each of the sixty protocols and the assays to which they 
are associated, are displayed in the Protocols Tree of the main window.
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The Main Window
The Main software window is comprised of six functional elements. These 
elements provide you with a means of accessing all of the instrument devices and 
features and include:

Main Menu

Tool Bar

Protocol Tree

Replay Tree

SpectraView Window

Report Window

Figure 2-4 The Main Window.
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The Menu Bar
At the top of the QuantaSmart main window is the Menu bar. The Menu bar 
consists of the File, Run, View, Libraries, Tools, IPA, Diagnostics, Window and 
Help menus, each of which offers a variety of selections and commands. Make 
menu selections by using the mouse pointer to select a menu bar item. Click on 
an item to display a list of options within that menu. To select a menu option, 
point to that item using the mouse and click on the item. 

Alternatively, all menu items can also be displayed using the underlined keys 
indicated. Menus are displayed with the Alt-underlined key selection; menu items 
can be selected by using the underlined key alone, while the item is visible and 
enabled. Menu items for functions that are not appropriate in the current 
circumstance are disabled (dimmed) in the menu.

The File Menu
The items in the File menu allow you to create and open assays, associate and 
disassociate assays to protocols and print assay information. 

The Run Menu
The Run menu allows you to control sample counting and cassette movement on 
the instrument’s sample changer deck. You can also access the Priostat functions 
via this menu. Priostat allows you to interrupt the current protocol to count a set 
of priority samples.

The View Menu
This menu allows you to hide or show certain components of the main window, as 
well as update the Protocols Tree. If your instrument is equipped with the Replay 
feature, the Replay Tree can also be updated using the View menu.

The Libraries Menu
The Libraries menu allows you access to the Sample Nuclides and Quench 
Standards libraries. If your instrument is equipped with the Alpha Beta option, the 
Alpha Beta Nuclides and Alpha Beta Standards libraries will also be available.

The Tools Menu
This menu allows you to access the Radionuclide Decay Calculator, to show 
certain errors for a protocol and view special spectral displays.

The IPA Menu
The IPA™ menu allows you to assign and display the various parameters used for 
Instrument Performance Assessment.

The Diagnostics Menu
The item in the Diagnostics menu provides access to troubleshooting and 
diagnostic functions for your PerkinElmer Technical Service Representative.
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The Window Menu
This menu allows you to define a format for the window display on the monitor 
and restore the SpectraView window. 

The Help Menu
The Help menu allows you access to the online help associated with the 
QuantaSmart program.

The Instrument Status Bar
The Instrument Status Bar contains a series of graphical buttons which allows you 
to Stop and Start the instrument and end a current protocol. It also provides you 
with information regarding the status of a current protocol and displays 
instrument messages.

The Protocols Tree
The Protocols Tree displays each of the available protocol flag numbers and the 
assay names that you have associated to the flag numbers. Existing reports are 
also shown in this view. During protocol execution, this window displays different 
symbols to provide a visual indication of the protocol currently being executed, 
which protocols have remaining cycles, which protocols have been completed and 
certain protocol errors.

Symbols Used in the Protocols Tree
During a protocol execution, the following symbols may be displayed in the 
Protocols Tree:

Flags

The protocol flag associated with an assay will change from white or yellow to 
green when a sample counting cycle begins. A yellow flag indicates that one cycle 
count for this assay has been completed, but the assay has remaining cycles. The 
red flag is for sample counting with Priostat. This flag will turn from red to green 
when the Priostat protocol begins counting. A checkered flag is displayed when all 
the assay count cycles are completed.

Report Symbol

A grey box indicates that a report has been defined for an assay. The report name 
appears next to this symbol in the Protocols Tree.
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Prohibitory Symbols

A red prohibitory symbol indicates that a protocol cannot be counted. Typically, 
this will result when no assay is associated with a protocol flag that the 
instrument has detected. This symbol could also indicate that an assay file has 
been deleted. A yellow prohibitory symbol indicates that data analysis cannot be 
performed. Typically, this will result when an appropriate standard set is missing 
from the Nuclide Library, or it has been modified in the Library but not recounted 
after the changes were made.

The Replay Tree
If your machine is equipped with the Replay feature, the Replay Tree displays a 
directory of folders containing previously collected data which can be reanalyzed 
using different data reduction conditions, without recounting the samples. 

In addition, any electronic data files saved as part of a Replay session will also 
appear in a dedicated subfolder under the original Replay folder.

The SpectraView Window
The SpectraView window displays a two-dimensional, real-time view of the 
spectrum for the current sample. It provides you with information about the 
status of a sample count and the region settings used in the counting procedure. 
A number of display options are available for the spectrum and are defined in this 
window. 
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The SpectraView window is typically used for the following:

1. Monitoring sample counting.

2. Detecting spectral distortions or compressions resulting from sample quench.

3. Observing the effect of altering the counting region settings.

4. Viewing the spectrum in linear or logarithmic scale.

Figure 2-5 The SpectraView Window.

Sample Number
This field indicates the Sample Number of the sample currently counting.

Count Time 
This field indicates the length of time each sample will be counted, as defined in 
the assay.



 THE SYSTEM SOFTWARE 

 PerkinElmer Life and Analytical Sciences 13 

Pre-count Delay
This field indicates the length of time each sample will remain in the instrument’s 
detection chamber prior to counting.

Note: This process is dark adaption. It allows luminescence 
emanating from a vial to dissipate prior to counting. Luminescence 
can distort the count statistics of the sample and is particularly 
problematic with low count rate samples. 

Acquisition Time
This is the length of time the current sample has been counting.

Apply AEC
If tSIE/AEC is selected as the quench indicating parameter for the assay, the 
sample spectrum can be displayed with or without AEC (Automatic Efficiency 
Correction). Activating this feature will adjust the region settings to account for 
sample quench. Mark this box to display the sample spectrum using AEC.

keV Full Scale 
This field allows you to alter the scale used to display the X-axis of the sample 
spectrum. Enter a number in this field if you would like to manually define the 
endpoint for the X-axis. By using the Auto setting, the X-axis will automatically 
adjust between zero and the upper level region limit defined in this window.

Counts Full Scale 
This field allows you to alter the scale used to display the Y-axis of the sample 
spectrum. Enter a number in this field if you would like to manually define the 
count maximum for the Y-axis. By using the Auto setting, the Y-axis will 
automatically adjust to the count rate of the sample.

Log keV Scale
This field allows you to display the X-axis using a logarithmic keV scale. The 
default setting plots the X-axis using a linear scale.

Linear keV Scale
This field allows you to view the X-axis using a linear scale. This is the default 
setting for the X-axis scale. Clicking this button will deselect this feature.

Regions 
These represent the Upper Level and Lower Level counting region limits for 
regions A, B and C.
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CPM
These fields display the CPM (Counts Per Minute) for Regions A, B and C. The 
gross counts per channel cumulatively equal the counts per region. The gross 
counts per region are divided by the count time to calculate CPM (Counts Per 
Minute) for each region.

2S%
This represents the gross uncertainty in a count value (with 95% confidence 
limits).

The Output Window
Output Window(s) display the named reports that you have defined on the Report 
Definition tab. A separate window will appear for each of the reports that you 
define and name in the assay. A typical Report Output window is shown below.

Figure 2-6 Report Output Window.
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Libraries
Radionuclide information is stored and accessed in the Nuclide Library. The 
Nuclide Library consists of the Quench Standards and Sample Nuclides libraries. If 
your instrument is equipped with an Alpha Beta option, an Alpha Beta Standards 
and an Alpha Beta Nuclides Library will also be available. 

The Quench Standards Library is comprised of quench sets, with each quench set 
containing individual quench standards. The data generated in quench standards 
assays is stored in this library and used to construct quench curves for calculating 
DPM (Disintegrations Per Minute) in DPM Assays. Quench Standards are counted 
once and the entire spectrum for each quench standard is stored independent of 
assay information. This allows you to select and use the same quench set in any 
number of assays and construct a quench curve for each sample at the time the 
sample is counted.

The Sample Nuclides Library allows you to specify and save nuclide names, 
counting region limits and quench sets for sample nuclides. Up to three nuclides 
can be defined for each entry to support the counting of multiple nuclides. These 
sample nuclide parameters are typically specified as part of the assay definition 
process and may be edited as needed.

The Alpha Beta Standards and Alpha Beta Nuclides libraries are used in the same 
manner as the Quench Standards and Sample Nuclides libraries. The information 
stored in these libraries is relevant only when performing Alpha Beta Assays, 
where both an Alpha-emitting and a Beta-emitting radionuclide are quantified 
independently within the same sample vial.

Display the Libraries menu by selecting Libraries from the menu bar.
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Chapter 3

About the System
Scintillation Counting

A liquid scintillation counter relies on the interaction between a beta-emitting 
radionuclide and a scintillator, a component of the scintillation cocktail. The 
scintillator converts ionizing radiation from the radionuclide into photons of light 
(scintillation). The intensity of the light produced during scintillation is 
proportional to the initial energy of the beta particle.

By placing a vial containing a radionuclide and scintillation cocktail into a dark 
detection enclosure (the instrument’s detector), the scintillation counter can 
measure photon intensity. A photosensitive device amplifies the light emitted from 
the sample vials and the amplified signal is converted to pulses of electrical 
energy and registered as counts. The counts accumulated during this process are 
sorted into separate channels, with the amplitude of the signal determining the 
energy channel (keV) into which the counts are sorted. The counts that are 
collected and sorted are used to generate the sample spectrum. Using this 
spectrum, the system can perform various count correction calculations and 
determine Counts Per Minute (CPM) for each sample. To calculate Disintegrations 
Per Minute (DPM), the instrument will determine the counting efficiency of each 
sample. Using a quench curve, the instrument compares the quench index for the 
samples to the quench index for the quench standards to determine sample 
counting efficiency and subsequently calculate DPM for the unknown samples.
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 The figure below provides an overview of this process:

Figure 3-1 An Overview of the Scintillation Counting Process.
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Sample Cassettes
Cassettes are the plastic racks which hold sample vials and allow them to be 
moved on the instrument’s sample changer deck. Samples are placed into 
cassettes that accommodate either standard or small vials without adapters (4ml 
vials require cassettes with adapters). The standard vial cassette can 
accommodate up to 12, 15-20ml vials. The mini vial cassette can accommodate 
up to 18, 6-7ml vials. The optional mini vial cassette can accommodate up to 18, 
4ml vials.

The individual cassettes are identified by unique numbers (cassette IDs) located 
at the end of each cassette. The protocol flag and cassette ID can be used as a 
means of providing Positive Sample Identification (PID) when utilizing the Worklist 
feature. The instrument moves the cassettes in a counterclockwise (forward) 
direction during sample analysis.

Figure 3-2 Sample Cassette with Protocol Flag.
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Protocol Flags
Protocol flags are numbered, plastic devices that contain an encoded, reflective 
metal that the instrument uses to identify the appropriate assay counting 
parameters for a set of samples. The counting parameters that the instrument 
uses correspond to the parameters that you define during the assay definition 
process (these are predefined by PerkinElmer Life and Analytical Sciences for the 
Direct DPM Assay). These assay parameters become a functional part of a 
protocol once you associate the assay to a protocol number.

Prior to counting samples, you must attach the correct protocol flag (the protocol 
flag number to which you have associated the assay) to the first cassette to be 
counted. Be sure the protocol flag is in the reset position (the flag is all the way to 
the left when the flag is on the left end of the cassette). When the protocol 
number is recognized, a reset flag indicates that the assay is being counted for 
the first time. If multiple cycles have been defined for the assay, the cycle 
counting starts over. The system will physically SET the flag after the cassette has 
been counted. Subsequent counting of the protocol is considered to be the 
following cycles of the same samples. You should RESET the protocol flag each 
time that you put new samples into the cassette(s).

Controlling the Sample Changer
Using several of the Run menu options, you can control the movement of the 
Sample Changer. 

The Stop menu item ends the current protocol and stops the instrument.

The Start/Resume Counting menu item loads the sample currently at the detector 
position and begins counting.

The Next Sample menu item unloads any sample in the detector, moves the next 
sample into the detector and starts counting.

The Next Protocol menu item unloads any sample in the detector and aborts the 
current protocol. The instrument searches for the next cassette with an active 
protocol flag and begins running that protocol.

The End Protocol menu item unloads any sample in the detector and ends the 
protocol; data reduction continues until data from the last counted sample is 
reported. The system begins counting the next protocol.

The Forward menu item unloads any sample in the detector and moves the 
sample changer in a counterclockwise direction. 

The Reverse menu item unloads any sample in the detector and moves the 
sample changer in a clockwise direction.
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Printing Reports
There are a variety of reports you can generate using the QuantaSmart system. In 
the Reports Definition tab of the Assay Definition window you can define the 
reports you would like to generate and you may select individual or block data 
items (a group of related parameters) for these printouts. Once you begin a 
counting protocol, the name of the assay and the name of the report(s) that you 
have defined for this assay will be displayed in the Protocols tab of the main 
window next to the protocol flag number to which you have associated this assay. 
Any printed reports you define will automatically print after an assay is completed. 
To print additional reports, select the report you would like to print from the 
Protocols tab of the main window. The Output Window is displayed. Click the print 
button to print the report.

Printing Assay Parameters
To print a list of the parameters you have selected for an assay, select the File-
Print Assays menu option. The Select Assays to Print window is displayed. Select 
an assay that you would like to print and click OK. 

Getting Started
When you are ready to begin a counting procedure, you will need to perform the 
following tasks:

1. Calibrate and Normalize the instrument.

2. Select an assay type: Alpha Beta, Alpha Beta Standards, CPM Assay, DPM 
Single, DPM Dual, DPM Triple, FS DPM, Direct DPM, Quench Standards or 
Single Photon Counting. The choice of assay types will differ depending on the 
TriCarb model you possess.

3. For any DPM Assay except Direct DPM, create quench data by acquiring 
quench standard data through quench standard assay.

4. Define and save the new assay parameters.

5. Associate (link) the assay parameters to a protocol.

6. Attach the correct protocol flag to the first cassette to be counted and load the 
cassette(s) with samples.

7. Start the instrument. Do not use the system’s CD writer while the instrument is 
counting.

Refer to the remaining chapters in this manual, or the online help documentation 
for details regarding the tasks above.
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Chapter 4

Calibration, Normalization and IPA
Before any samples are counted, you should calibrate, normalize and assess the 
performance of the instrument.

Calibration
During calibration, the voltage applied to each of the Photomultiplier Tubes 
(PMTs) is adjusted until the two tubes have been synchronized in their response 
to a purged, unquenched, factory-supplied Carbon-14 standard. This process is 
designed to assure that the instrument accurately quantifies the energy from all 
beta particle emissions. 

Normalization
Normalization is a process that allows the system to establish a scale to assign 
numerical values for sample quench. During normalization, a purged, unquenched 
factory-supplied Carbon-14 standard is counted, and a value of 1000 is assigned 
as the lowest allowable value for the Quench Indicating Parameter, tSIE 
(transformed Spectral Index of the External Standard). Sample quench is 
measured and numerical values can be assigned based on the least quenched of 
1000 that was established with the unquenched standard.

IPA
During IPA (Instrument Performance Assessment), the instrument measures the 
following parameters for both Tritium and Carbon-14:

Background counts.
Counting efficiency.
Figure-of-Merit (Efficiency2/B, or sensitivity).
Chi-Square (reproducibility).

The IPA feature is standard on the 3100 series, and optional on the 2900 and 
2800 series instruments.
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When to Perform these Procedures
The calibration, normalization and IPA procedures occur automatically by leaving 
the Self-Normalization and Calibration (SNC) and IPA cassette (containing the 
Carbon-14 calibration standard, unquenched Tritium standard and background 
standard) on the instrument counting deck at all times. Whenever the SNC 
protocol flag is read by the instrument, a 23-hour timer is checked. 

Note:Calibration, Normalization and IPA on an instrument 
equipped with a BGO detector guard does not occur by virtue of 
the 23-hour timer. It occurs each time the SNC protocol flag is 
detected by the instrument.

If 23 hours have elapsed since the previous calibration and normalization, the 
instrument will perform the SNC/IPA procedure. If 23 hours have not elapsed 
since the previous calibration and normalization, the SNC/IPA cassette is bypassed 
and this procedure is not performed. Ideally, the instrument Calibration, 
Normalization and Instrument Performance Assessment should be performed on 
this timed, 23-hour (~daily) cycle. If these procedures are performed using the 
timer, they should not interfere with sample counting, since they will occur 
overnight. Certain IPA parameters will need to be defined prior to the machine 
performing the assessment procedures. You may also choose to perform 
instrument calibration, normalization and IPA manually (not using the 23-hour 
timer) by “resetting” the protocol flag on the cassette.

An IPA report is generated after each IPA procedure is completed. To access the 
data generated from all IPA runs, select IPA Charts & Tables from the IPA menu.
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Defining the IPA Parameters
Before performing any IPA procedures you must define the parameters that the 
instrument will use in the assessment process. To define these parameters, select 
IPA Definition from the IPA menu. The IPA Definition window is displayed:

Figure 4-1The IPA Definition Window.



 CHAPTER 4  

 26 PerkinElmer Life and Analytical Sciences 

3H (Tritium) Standard DPM
Enter the DPM value for the unquenched, sealed Tritium standard (supplied). The 
DPM values for standards purchased from PerkinElmer Life and Analytical Sciences 
are printed on the vial. 

3H (Tritium) Reference Date
Enter the reference (calibration) date for the unquenched Tritium standard. This is 
the date on which the standard has the specified amount of activity. You must 
enter this value for half-life correction to occur. The Reference Date for standards 
purchased from PerkinElmer Life and Analytical Sciences is printed on the vial.

14C (Carbon-14) Standard DPM
Enter the DPM value for the unquenched, sealed Carbon-14 standard (supplied). 
The DPM values for standards purchased from PerkinElmer Life and Analytical 
Sciences are printed on the vial. No reference date is required due to the long 
half-life of Carbon-14.

Background Count Time
This is the length of time (in minutes) the instrument will measure the 
background counts. The background for both Carbon-14 and Tritium are collected 
simultaneously. Typically, a default 60 minute count time is used to assess 
background.

3H (Tritium) E2/B (Figure of Merit) Threshold
This is the lower limit for the calculated Tritium figure of merit value. If the figure 
of merit value falls below the defined threshold, a message is displayed in the 
main window. If this occurs, it indicates either an increase in background or a 
decrease in efficiency. Typically, the default threshold can be used until sufficient 
IPA data for this parameter is collected and an alternate threshold is established.

14C (Carbon-14) E2/B (Figure of Merit) Threshold
This is the lower limit for the calculated Carbon-14 figure of merit value. If the 
figure of merit value falls below the defined threshold, a message is displayed in 
the main window. If this occurs, it indicates either an increase in background or a 
decrease in efficiency. Typically, the default threshold can be used until sufficient 
IPA data for this parameter is collected and an alternate threshold is established.

Do Chi Square Tests: for 3H (Tritium)?
Mark this box to enable a test that measures the degree of reproducibility for 
Tritium sample counting.   If the Chi-Square value for a Tritium standard counted 
20 times falls within an acceptable range of values, the variation in individual 
sample counts is a result of the count statistics of the sample, as opposed to an 
instrument problem. 
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Do Chi Square Tests: for 14C (Carbon-14)?
Mark this box to enable a test that measures the degree of reproducibility for 
Carbon-14 sample counting.   If the Chi-Square value for a Carbon-14 standard 
counted 20 times falls within an acceptable range of values, the variation in 
individual sample counts is a result of the count statistics of the sample, as 
opposed to an instrument problem.

RS-232 Transmit IPA Data?
Mark this box if you would like to transmit the IPA data to an external device, via 
the RS-232 communications port.

Save IPA Data To Text File
Clicking on this box enables the File Name field. You can then directly enter the 
path to where you want the IPA data saved as a text file.

# of Datapoints to Establish Baselines
Enter the number of IPA runs you would like to use to generate baselines for 
Tritium and Carbon-14 background and efficiency. The range for this value is 
between five and 99.

Tritium Background Mean and Limit
The instrument calculates the mean value for Tritium background from the 
number of IPA runs (datapoints) specified. This limit is calculated as 4SE 
(statistical error based on counts) above the baseline. When the limit is reached, 
a message is displayed in the main window.

14C (Carbon-14) Background Mean and Limit
The instrument calculates the mean value for Carbon-14 background from the 
number of IPA runs (datapoints) specified. This limit is calculated as 4SE 
(statistical error based on counts) above the baseline. When the limit is reached, 
a message is displayed in the main window. 

3H (Tritium) Efficiency Mean and Limit
The instrument calculates the mean value for Tritium efficiency from the number 
of IPA runs (datapoints) specified. This limit is calculated as 3% below the 
baseline, or less than 58% efficiency. When the limit is exceeded, a message is 
displayed in the main window.

14C (Carbon-14) Efficiency Mean and Limit
The instrument calculates the mean value for Carbon-14 efficiency from the 
number of IPA runs (datapoints) specified. This limit is calculated as 3% below 
the baseline. When the limit is exceeded, a message is displayed in the main 
window.
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Reset Baselines
Click this button to delete the current baselines. The instrument uses the data 
from the number of IPA runs specified in the # of Datapoints to Establish 
Baselines field to establish new baselines. The range for this value is between five 
and 99.

Running the SNC Protocol for an Instrument without Super Low 
Level Counting Ability:

After defining the IPA parameters:

1. To run the SNC/IPA protocol, regardless of how long it has been since it last 
ran, reset the SNC protocol flag to the “reset position (the flag is all the way to 
the left when the flag is on the left end of the cassette). If the protocol flag is 
not “reset”, the SNC/IPA protocol will only run if 23 hours have elapsed since 
the last time that the protocol was run.

Note: The cassette must be loaded in the following order:

Figure 4-2 Standard SNC/IPA Cassette Loading.
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2. Load the purged, unquenched Carbon-14 standard (supplied) into the first 
position of the cassette (this is at the same end as the protocol flag).

Caution: Do not use the unpurged, Low Level standards to 
calibrate the instrument, even if the instrument is to be used in 
Low Level, High Sensitivity or Super Low Level count mode. 

3. Load the purged, unquenched Tritium standard (supplied) into the second 
cassette position.

4. Load the purged background standard (supplied) into the third cassette 
position.

If the instrument is IDLE (not counting):

5. Load the calibration cassette on the right-hand side of the sample changer 
deck such that you can read the protocol flag. 

Press the Start button to begin counting.

If the instrument is currently counting a sample:

Load the calibration cassette after the last cassette belonging to the current 
protocol. When the current protocol is completed, the calibration cassette will 
automatically move into the counting position. After the SNC flag is read by the 
instrument, the calibration, normalization and IPA procedure begins and the 
flag is automatically returned to the “non-reset” position. 

To access the data generated from the IPA runs, select IPA Charts & Tables from 
the IPA menu.
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Running the SNC Protocol for an Instrument with Super Low Level 
Counting Ability (with a BGO Detector Guard):
After defining the IPA parameters:

1. The SNC/IPA protocol will run every time that the protocol plug is recognized, 
regardless of the state of the protocol flag or how long it has been since it was 
last run.

Note: The cassette must be loaded in the following order:

Figure 4-3 Super Low Level SNC/IPA Casette Loading.

2. Load the purged, unquenched Carbon-14 standard into the first position of the 
cassette (this is at the same end as the protocol flag).

Caution: Do not use the unpurged, Low Level standards to 
calibrate the instrument, even if the instrument is to be used in the 
High Sensitivity, Low Level, or Super Low Level count mode. 

3. Load an empty vial into the second cassette position.

4. Load the purged, unquenched Tritium standard into the third cassette position.

5. Load the purged background standard into the fourth cassette position.

6. If the instrument is IDLE (not counting), load the calibration cassette on the 
right-hand side of the sample changer deck such that you can read the 
protocol flag and press the Start button to begin counting.
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If the instrument is currently counting a sample, load the calibration cassette 
after the last cassette belonging to the current protocol. When the current 
protocol is completed, the calibration cassette will automatically move into the 
counting position. After the SNC flag is read by the instrument, the calibration, 
normalization and IPA procedure begins.

Once you have defined the IPA parameters and performed IPA, you can access 
the data generated from the IPA runs by selecting IPA Charts & Tables from 
the IPA menu. 

Note: Calibration, Normalization and IPA on an instrument 
equipped with a BGO detector guard does not occur by virtue of 
the 23-hour timer. It occurs each time the SNC protocol flag is 
detected by the instrument.
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The IPA Results
An IPA report is generated after each IPA procedure is completed. Data for all IPA 
parameters may be viewed, edited or printed via the IPA Charts & Tables menu 
option.

Figure 4-4 IPA Charts & Tables.

When the data is displayed as a table, points can be included or excluded from 
the data set. The right axis on the chart represents Standard Deviation, while the 
left axis represents the Mean value or baseline value for the selected IPA 
parameter depending on which type of chart is displayed. Using the print button 
in the IPA Charts & Tables window, you may print an individual chart or table, or 
you may print all the IPA charts and tables.



 CALIBRATION, NORMALIZATION AND IPA 

 PerkinElmer Life and Analytical Sciences 33 

The following IPA charts are available:
14C (Carbon-14) Background
This chart displays the results of the IPA test for Carbon-14 background counts. 
This test checks for detector contamination or light leaks. The limit for this 
parameter is > baseline + 4 Standard Deviations (SD). The mean and SD for this 
parameter are recalculated as new IPA data are generated.

14C (Carbon-14) Background Baseline
This chart displays the Carbon-14 background data based on a fixed baseline 
value. The number of values used to generate the baseline is programmable and 
is defined in the IPA Definition window. The default for this setting is five.

14C (Carbon-14) Chi-Square
This chart displays the results of the IPA test that measures the reproducibility of 
sample counting for Carbon-14. The test is performed by counting a single sample 
in the detector 20 consecutive times with a count time of 30 seconds for each 
repeat measurement. The normal range for this value is 7.63 to 36.19. A properly 
performing instrument may generate Chi-Square values outside this range 5% of 
the time, due to the statistical nature of the test. The mean and SD for this 
parameter are recalculated as new IPA data are generated.

14C (Carbon-14) Efficiency
This chart displays the results of repeated Carbon-14 efficiency determinations. 
The mean and SD for this parameter are recalculated as new IPA data are 
generated.

14C (Carbon-14) Efficiency Baseline
This chart displays the Carbon-14 efficiency data based on a fixed baseline value. 
The number of values used to generate the baseline is programmable and is 
defined in the IPA Definition window. The default for this setting is five.

14C (Carbon-14) Figure of Merit
Figure of Merit (FOM) is a measure of the sensitivity of the instrument for Carbon-
14 based on the instrument’s counting efficiency and background. The mean and 
SD for this parameter are recalculated as new IPA data are generated.

3H (Tritium) Background
This chart displays the results of the IPA test for Tritium background counts. This 
test checks for detector contamination or light leaks. The limit for this parameter 
is > baseline + 4 Standard Deviations (SD). The mean and SD for this parameter 
are recalculated as new IPA data are generated.
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3H (Tritium) Background Baseline
This chart displays the Tritium background data based on a fixed baseline value. 
The number of values used to generate the baseline is programmable and is 
defined in the IPA Definition window. The limit for this parameter is > baseline + 
4 Standard Deviations (SD). The default for this setting is five.

3H (Tritium) Chi-Square
This chart displays the results of the IPA test that measures the reproducibility of 
sample counting for Tritium. The test is performed by counting a single sample in 
the detector 20 consecutive times with a count time of 30 seconds for each repeat 
measurement. The normal range for this value is 7.63 to 36.19. A properly 
performing instrument may generate Chi-Square values outside this range 5% of 
the time, due to the statistical nature of the test. The mean and SD for this 
parameter are recalculated as new IPA data is generated.

3H (Tritium) Efficiency
This chart displays the results of repeated Tritium efficiency determinations. The 
mean and SD for this parameter are recalculated as new IPA data is generated. 
The limit for this parameter is < baseline minus 3%.

3H (Tritium) Efficiency Baseline
This chart displays the Tritium efficiency data based on a fixed baseline value. The 
number of values used to generate the baseline is programmable and is defined in 
the IPA Definition window. The default for this setting is five. The limit for this 
parameter is < baseline minus 3%.

3H (Tritium) Figure of Merit
Figure of Merit (FOM) is a measure of the sensitivity of the instrument for Tritium 
based on the instrument’s counting efficiency. The mean and SD for this 
parameter are recalculated as new IPA data are generated.

When the data is displayed as a table, points can be included or excluded from 
the data set. The right axis on the chart represents Standard Deviation, while the 
left axis represents the Mean value or baseline value for the selected IPA 
parameter depending on which chart is displayed. Using the print button in the 
IPA Charts & Tables window, you may print an individual chart or table, or you 
may print all the IPA charts and tables.
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Chapter 5

Defining a CPM Assay
This chapter of the Getting Started manual describes the process for defining 
simple CPM assays. Information pertaining to Count Modes, Count Correction 
features and Quench Indicating Parameters is not addressed in this chapter. For 
detailed information regarding complex assays, please refer to the online help 
associated with the QuantaSmart program.

The CPM Assay
The CPM assay provides you with information regarding the total quantity of 
radioactivity within a sample, in one, two, or three defined counting regions, 
without regard to counting efficiency or sample interference, such as quench. The 
data generated from the assay is expressed in CPM (Counts Per Minute). 

Prior to defining a CPM assay, the instrument should be properly calibrated. Refer 
to Chapter 4 of the Getting Started Manual, or the online help documentation for 
details regarding calibration.
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Selecting a CPM Assay 
Before defining a CPM assay, you must create a new assay by selecting New 
Assay from the File menu. The Select Assay Type window is displayed below.

Figure 5-1 The Select Assay Type Window.

Select CPM from the Select Assay Type window and click OK. The Assay Definition 
window is displayed.

Note: For information regarding other assay types, please refer to 
the online help documentation for the QuantaSmart program.
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The Assay Definition Window
Assays are defined by entering information into the seven Assay Definition tabs 
within the Assay Definition window: Assay Parameters, Count Conditions, Count 
Corrections, Report Definition, Report Output, Special Files, and Worklist. Using 
these windows for each CPM assay that you define, you will:

Enter descriptive information about the nature of the assay and specify an 
author of the assay.
Define a sample nuclide in the sample nuclides library if one does not already 
exist.
Link the nuclide to the assay.
Specify the appropriate count conditions and count correction factors that the 
instrument will use to analyze the samples.
Define the reports you would like the system to generate. 
Define an optional worklist to designate Positive Identification numbers and 
sample names that correspond to sample numbers on a printout, if desired. 
Refer to the online help documentation for details regarding Worklists.

The parameters defined within the context of these tabs can be saved and used 
or edited at your discretion. 
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Assay Parameters
The Assay Parameters tab allows you to designate an author and provide 
descriptive information for an assay. You may also prohibit the editing of assay 
parameters using this window. 

Figure 5-2 The Assay Parameters Tab.

Password
Enter a password (optional) to restrict editing functions for this assay. You must 
check the Lock Assay box before you can enter a password in this field.

Note:You cannot retrieve a lost or forgotten password.

Lock Assay
Mark this box if you would like to restrict editing functions for this assay. You must 
enter a password in the Password field if you would like to lock the assay.

Author
Enter your name or other identification as the author of the assay. 
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Assay Description
Enter descriptive information about the assay. This information is for future 
reference and is stored permanently with the assay. It does not appear in the 
reports.

Note: For information regarding the individual assay parameters, 
please refer to the “Assay Parameters” topic in the online help 
documentation.

Count Conditions
The Count Conditions tab allows you to define specific counting parameters for an 
assay.

Figure 5-3 The Count Conditions Tab.
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Name
Click this button to display the Sample Nuclides Library window.

Figure 5-4 The Sample Nuclides Library Window.

This window allows you to enter information into and retrieve information from 
the Sample Nuclides Library. You can use the Sample Nuclides Library to define 
and save nuclide names and counting region limits for radionuclides in your 
samples. You can also link quench sets to nuclides for DPM assays (optional for 
the TriCarb 2800TR).

Select the appropriate nuclide(s) for your assay from the list provided and click 
OK. 

Assay Count Cycles
Enter the number of times you would like the assay to count. The assay is 
recounted after it has moved one complete cycle around the sample changer 
deck. Any samples on the sample changer deck will be counted prior to your 
samples being recounted.

Count Time
Enter the maximum length of time that the samples will be counted (up to 
9,999.99 minutes). Typically, a longer count time provides better count statistics. 
Two other count terminators, 2 Sigma% and Low Count Reject (LCR), allow you 
to terminate sample counting or either counting statistics or low activity.
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Background Subtract
Mark this box to subtract background CPM from all samples.   The background 
value is established in one of three ways. The method used is selected from the 
drop down list:

When the 1st Vial background subtraction method is implemented, the instrument 
counts the first vial in an assay for either ten minutes or the defined assay count 
time (whichever is greater) and establishes a CPM value for each region; these 
are the background values subtracted from each sample within each region of the 
assay.

When the IPA background subtraction method is implemented, the instrument 
subtracts the background values established during the Instrument Performance 
Assessment procedures from the entire spectrum of each sample. The 
background spectra are stored during these procedures and are available for any 
counting region.

The Manual background subtraction feature allows you to enter the CPM values 
you would like the instrument to subtract from each counting region of the 
samples.

Note:For information regarding additional items in the Count 
Conditions tab, please refer to the “Count Conditions” topic in the 
online help documentation.
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Count Corrections
The Count Corrections tab allows you to activate certain instrument devices or 
features and define count correction parameters.

Figure 5-5 The Count Corrections Tab.

Static Controller
The instrument’s static-controlling device, which is designed to reduce static 
originating on the sample vial, is automatically enabled. Static discharge can 
falsely elevate sample counts by producing non-beta pulses. This device should be 
activated in most cases. It is especially important in low humidity conditions, 
when using plastic vials and when handling vials with latex gloves. To further 
reduce the likelihood of generating static:

Maintain a relative humidity level above 40%.
Wipe latex gloves with anti-static wipes before handling vials.
Use the “Pre-count delay” timer which delays the counting of each sample 
while static-induced pulses dissipate.
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Luminescence Correction
Mark this box to activate luminescence correction. The instrument corrects the 
data for counts resulting from sample luminescence.

Apply Half-life Correction
Mark this box to activate half-life correction. This feature is typically used when 
counting short half-life nuclides. The instrument corrects the sample counts for 
half-life decay of the nuclide(s) being counted. The Half-life value for the nuclide 
is taken from the nuclide entry in the Sample Nuclide Library. The Reference Date 
and Time are used to perform the decay calculation. The default settings for the 
Reference Date and Time correspond to the start of an assay.

Note: For information regarding additional count correction 
features, please refer to the topic “Count Corrections” in the online 
help documentation.



 CHAPTER 5  

 44 PerkinElmer Life and Analytical Sciences 

Report Definition
The Report Definition tab allows you to specify the data items that are reported 
and the format for reporting. Multiple reports can be defined for each assay. 

Figure 5-6 The Report Definition Tab.

Report Name
The Report Name field allows you to assign a descriptive name to a report. You 
can use the four buttons beside the Report Name list to add a new report, remove 
a named report, rename an existing report or reset the field selections to the 
original factory default.

Note: You cannot use special characters when naming reports.
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Report Fields
You may define several printed or electronic reports for each assay, each 
containing different data items. The Report Fields box contains a comprehensive 
list of the available data items. To select the data items you would like to include 
in a report, double-click on those items in the Report Fields box.

Add Button
Click on this button to add a Custom report field to those already available in the 
list of fields. You can define these custom fields for name, content and format as 
desired.

Delete Button
Click on this button to delete a Custom report field from the currently selected 
report. A confirmation window will prompt you to confirm the deletion.

Note: You cannot delete a Custom field if it is referenced by 
another equation. The referencing equation must be deleted or 
modified first.

Format Button
Click on this button to bring up a window allowing the formatting of the selected 
field. Specify the total number of digits and the number of decimal places for the 
overall width of the field.

For fields that may result in very large or very small numbers, you may choose 
Scientific Notation as shown in the following examples:

Examples:3.123e+006 is equivalent to 3.123 x 106 (3,123,000)
3.123e-003 is equivalent to 3.123 x 10-3 (0.003123)
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Equation... Button
Click on this button to create an equation associated with the selected Custom 
field (see the note above under Delete Button). The following window will appear:

Figure 5-7 Equation Window

Reference: Reiterates the value of another field, either for convenience of 
repeating the value or custom naming of the field.

Operands: You can enter a constant value or choose any valid report field for 
these values.

Operators: You can choose any of the mathematical operations available on the 
drop down lists. These include common logarithm, natural anti-logarithm and 
square-root for the unary (single operand) operators and addition, subtraction, 
multiplication and division for the binary (two operands) operators.
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Report Output
The Report Output tab offers options for how the report is output.

Figure 5-8 Report Output Window.

Major options offered in the Report Output window are printing the output to a 
printer, saving the output to a file, outputting the report to the RS-232 serial port, 
and tandem processing (running a printer, saving the output to a file, outputting 
the report to the RS-232 serial port, and tandem processing (running a program 
and a file after each batch, cycle, or sample).

Note:QuantaSmart automatically saves data as dated Results files 
for the optional Replay feature. However you can select other 
formats as reports, including Delimited Text (ASCII), Excel format, 
and Lotus 1-2-3 format.
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Special Files
The Special Files window allows you to select and configure information regarding 
files pertinent to the assays.

Figure 5-9 Special Files



 DEFINING A CPM ASSAY 

 PerkinElmer Life and Analytical Sciences 49 

Some of the major selections are making the following types of files:

Composite file-all sample spectra are saved in a single file.
Individual spectrum file - each file represents the spectrum of one sample
IPA data file
Prot.dat file
2000CA.dat file

Files are saved according to the path defined in the Data Output Path window 
when associating the assay to the protocol flag.

Once you have defined the assay parameters click the OK button in the Assay 
Definition window. Save the file to an appropriate folder, giving the file a 
descriptive name. Once you have saved the assay parameters, you must associate 
the assay to a protocol flag number, load the cassette with vials, load the 
instrument with cassettes, and begin counting the samples. 



 CHAPTER 5  

 50 PerkinElmer Life and Analytical Sciences 



 LOADING AND COUNTING SAMPLES 

 PerkinElmer Life and Analytical Sciences 51 

Chapter 6

Loading and Counting Samples
Before loading and analyzing samples, you must: 

1. Calibrate the instrument. Refer to Chapter 4 of the Getting Started manual, or 
the online help documentation for details regarding calibration.

2. Define the assay using the seven tabs in the Assay Definition window. 

3. Associate the assay to a protocol flag number.

Associating an Assay to a Protocol Flag Number
In the Protocols tab in the QuantaSmart main window, select a flag number that 
you would like to link to an assay. Right click on that selection. Select Associate 
Assay from the menu. You may also select Associate Assay from the File menu. 
menu. 

Figure 6-1 Associating an Assay to a Protocol Flag Number.

The Associate Assay window is displayed. Select an assay that you would like to 
link to the protocol.   The Data Paths window is displayed. Enter a User ID and 
Additional Header (optional). Click OK. The file name of the assay you have linked 
should appear in the Protocols Tree with the flag number to which you have 
associated the assay. 
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Loading the Cassette with Vials
A cassette is a plastic device that moves sample vials on the instrument’s sample 
changer deck. Load the vials into the cassette(s) as shown below:

Figure 6-2 A Cassette Containing Sample Vials.

The first cassette in a protocol must contain the appropriate protocol flag number 
in the reset position (the flag is all the way to the left when the flag is on the left 
end of the cassette). The instrument moves the cassettes in a counterclockwise 
(forward) direction during sample analysis.

Loading the Instrument with Cassettes
To load the instrument, place the cassette(s) on the sample changer deck so that 
the protocol number on the flag is facing you. If the instrument is in the process 
of analyzing samples, place your cassettes after the last cassette in the currently 
counting assay. Your samples will be analyzed immediately after the current assay 
is completed. If the instrument is not in use, place your cassettes on the right side 
of the sample changer deck such that no other cassettes are between your 
samples and the far wall of the sample changer deck. 

Counting Samples
Begin counting samples by selecting the Start button in the toolbar of the 
QuantaSmart main window. The instrument moves the first cassette into position, 
the first sample loads into the detection chamber and sample counting begins. Do 
not use the system’s CD writer while the instrument is counting.
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Printing Reports
A report symbol is displayed in the Protocols Tree of the main window for each 
currently counting assay. The printed report(s) you define for an assay will 
automatically print after the assay is completed if printout is chosen in the Report 
Output tab. To print additional reports, select the report symbol for the report you 
would like to print. The Output Window is displayed. Click the print button to print 
the report.

The Output Window
Output Window(s) display the named reports that you have defined on the Report 
Definition tab. A separate window will appear for each of the reports that you 
define and name in the assay. A typical Report Output window is shown in below:

Figure 6-3 Report Output Window.



 CHAPTER 6  

 54 PerkinElmer Life and Analytical Sciences 



 DEFINING A QUENCH STANDARDS ASSAY 

 PerkinElmer Life and Analytical Sciences 55 

Chapter 7

Defining a Quench Standards Assay 
This chapter of the Getting Started manual describes the process for defining 
simple Quench Standards assays. Information pertaining to Count Modes, Count 
Correction features and Quench Indicating Parameters is not addressed in this 
chapter. For detailed information regarding complex assays, please refer to the 
online help associated with the QuantaSmart program.

Quench
In a sample vial, the scintillation cocktail converts radioactive emissions from the 
sample nuclide into photons of light. The liquid scintillation analyzer detects this 
light when photons enter the photomultiplier tube (PMT) of the detector. 
Quenching occurs when something interferes with either the production or the 
detection of this light. Two types of quench can interfere with sample counting:

Chemical Quench
Chemical quenching occurs when a chemical agent interferes with the production 
of photons in the scintillator. As a result, the spectrum from a chemically 
quenched sample is compressed toward the low end of the (keV) energy scale. 

Color Quench
Color quenching occurs when a colored agent interferes with the detection of 
photons. As a result, the height of the spectrum from a color-quenched sample is 
depressed. In cases of severe color quenching, the spectrum may also be 
compressed toward the low end of the (keV) energy scale. 

In either case, quench affects sample counting efficiency since fewer photons are 
detected by the instrument.
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Quench Curves
Quench Standards Assays are performed so that quench curves can be stored in 
the Quench Standards Library. A quench curve correlates sample counting 
efficiency to a Quench Indicating Parameter (QIP), SIS or tSIE. The quench 
indicator value for a sample is determined during sample counting. This value is 
used to interpolate the counting efficiency for a sample from the quench curve 
(where% Efficiency is plotted vs. the QIP). The interpolated efficiency value is 
used to calculate the DPM (Disintegrations Per Minute) for the sample, where 
DPM=CPM/Efficiency. 

The system stores the spectrum of each standard in a quench standards set. The 
quench curve is constructed from the appropriate quench standards set as 
needed. The quench standards set needs to be counted one time only, as the 
quench data is available for use in any assay. You may establish a number of 
different quench standards sets for various nuclides in different sample matrices.

The Quench Standards Assay
The Quench Standards assay represents a comprehensive set of parameters that 
the system uses for the purpose of counting a quench standards set. A quench 
standards set is composed of a series of vials, each containing the same amount 
of nuclide with varying amounts of quenching agent. Using the data from the 
quench standards, a quench curve is generated to determine the counting 
efficiency and calculate DPM (Disintegrations Per Minute), where DPM=CPM/
Efficiency.

To accurately assess the level of quench within a sample, the chemical 
environment of the quench standards should reflect the chemical environment of 
the samples you would like to count.

Prior to defining a Quench Standards assay, the instrument should be properly 
calibrated. 
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Selecting a Quench Standards Assay
Before defining a Quench Standards assay, you must create a new assay by 
selecting New Assay from the File menu. The Select Assay Type window is 
displayed.

Figure 7-1 The Select Assay Type Window.

Select Quench Standards from the Select Assay Type window and click OK. The 
Assay Definition window is displayed.

Note: For information regarding other assay types, please refer to 
the online help documentation for the QuantaSmart program.
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The Assay Definition Window
Assays are defined by entering information into the seven Assay Definition tabs 
within the Assay Definition window: Assay Parameters, Count Conditions, Count 
Corrections, Report Definition, Report Output, Special Files, and Worklist. Using 
these seven tabs, for each quench standards assay that you define, you will:

Enter descriptive information about the nature of the assay and specify an 
author of the assay.
Define a quench standard in the Quench Standards library if one does not 
already exist.
Link the quench standard to the assay.
Specify the appropriate count conditions and count correction factors that the 
instrument will use to analyze the standards.
Define the reports you would like the system to generate. 
Define an optional worklist to designate Positive Identification numbers and 
sample names that correspond to sample numbers on a printout, if desired. 
Refer to the online help documentation for details regarding Worklists.

The parameters defined within the context of these seven tabs can be saved and 
used or edited at your discretion. 
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Assay Parameters
The Assay Parameters tab allows you to designate an author and provide 
descriptive information for an assay. You may also prohibit the editing of assay 
parameters using this window. 

Figure 7-2 The Assay Parameters Tab.

Password
Enter a password (optional) to restrict editing functions for this assay. You must 
check the Lock Assay box before you can enter a password in this field.

Lock Assay
Mark this box if you would like to restrict editing functions for this assay. You must 
enter a password in the Password field if you would like to lock the assay.

Author
Enter your name or other identification as the author of the assay. This is an 
optional entry.
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Assay Description
Enter descriptive information about the assay. This information is for future 
reference and is stored permanently with the assay.

Note: For information regarding the individual assay parameters, 
please refer to the “Assay Parameters” topic in the online help 
documentation.

Count Conditions
The Count Conditions tab allows you to define specific counting parameters for an 
assay.

Figure 7-3 The Count Conditions Tab.
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Name
Click this button to display the Quench Standards Library window.

Figure 7-4 The Quench Standards Library Window.

The Quench Standards window allows you to enter information into and retrieve 
information from the Quench Standards Library. You can use the Quench 
Standards Library to define and save the name, maximum energy value and the 
number of standards for each quench set for Quench Standards assays. The data 
from these quench sets are used to construct quench curves for determining DPM 
(Disintegrations Per Minute) in DPM assays. 

In the DPM field, enter the current DPM value of the quench standards you would 
like to count. If the quench standards set was purchased from PerkinElmer Life 
and Analytical Sciences, the DPM value and reference date are printed on the vial 
label. From this information, you can calculate the current DPM value using the 
Radionuclide Decay function of the QuantaSmart program. The Decay calculator is 
accessible via the Tools menu in the main window. Click Ok.

Note: The quench curve can be plotted after the quench standards 
are counted. To display the quench curve, click the Quench Curve 
button in the Quench Standards Library window. For additional 
information regarding quench curves, please refer to the “Quench 
Curve” topic in the online help documentation.
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Count Time
Enter the maximum length of time that the samples will be counted. Typically, a 
longer count time provides better count statistics. Two other count terminators, 2 
Sigma% and Low Count Reject (LCR), allow you to determine the minimum 
length of time that the sample will be counted. The default for this setting in a 
Quench Standards assay is 30 minutes.

Background Subtract
Mark this box to subtract background CPM from all samples. The background 
value is established in one of three ways. The method used is selected from the 
drop down list:

When the 1st Vial background subtraction method is implemented, the instrument 
counts the first vial in the protocol for either ten minutes or the defined protocol 
count time (whichever is greater) and establishes a CPM value for each region; 
these are the background values subtracted from each sample within each region 
of the assay.

When the IPA background subtraction method is implemented, the instrument 
subtracts the background values established during the Instrument Performance 
Assessment (IPA) procedures from the entire spectrum of each sample. The 
background spectra are stored during these procedures and are available for any 
counting region.

The Manual background subtraction feature allows you to enter the CPM values 
you would like the instrument to subtract from each counting region of the 
samples.

Note: For information regarding additional items in the Count 
Conditions tab, please refer to the “Count Conditions” topic in the 
online help documentation.
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Count Corrections
The Count Corrections tab allows you to activate certain instrument devices and 
define count correction parameters.

Figure 7-5 The Count Corrections Tab.

Static Controller
The instrument’s static-controlling device, which is designed to reduce static 
originating on the sample vial, is automatically enabled. Static discharge can 
falsely elevate sample counts by producing non-beta pulses. This device should be 
activated in most cases. It is especially important in low humidity conditions, 
when using plastic vials and when handling vials with latex gloves. To further 
reduce the likelihood of generating static:

Maintain a relative humidity level above 40%.
Wipe latex gloves with anti-static wipes before handling vials.
Use the “Pre-count delay” timer which delays the counting of each sample 
while static-induced pulses dissipate.
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Apply Half-life Correction
Mark this box to activate half-life correction. This feature is typically used when 
counting short half-life nuclides. The instrument corrects the sample counts for 
half-life decay of the nuclide(s) being counted. The Half-life value for the nuclide 
is taken from the nuclide entry in the Quench Standards Library. The Reference 
Date and Time are used to make the decay calculation. The default settings for 
the Reference Date and Time correspond to the start of an assay. In Quench 
Standards assays, activate this feature only if the DPM value entered into the 
Quench Standards Library for the nuclide in the standards has not been corrected 
for decay. If the DPM value entered into the library for the standards has been 
corrected for decay of the nuclide, the Half-life Correction feature should not be 
activated.

Note: For information regarding additional count correction 
features, please refer to the topic “Count Corrections” in the online 
help documentation.
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Report Definition
The Report Definition tab allows you to specify the data items that are reported 
and the format for reporting. Multiple reports can be defined for each assay.

Figure 7-6 The Report Definition Tab.

Report Name
The Report Name field allows you to assign a descriptive name to a report. You 
can use the four buttons beside the Report Name list to add a new report, remove 
a named report, rename an existing report or reset the field selections to the 
original factory default.

Note: You cannot use special characters when naming reports.
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Report Fields
You may define several printed or electronic reports for each assay, each 
containing different data items. The Report Fields box contains a comprehensive 
list of the available data items. To select the data items you would like to include 
in a report, double-click on those items in the Report Fields box.

Add Button
Click on this button to add a Custom report field to those already available in the 
list of fields. You can define these custom fields for name, content and format as 
desired.

Delete Button
Click on this button to delete a Custom report field from the currently selected 
report. A confirmation window will prompt you to confirm the deletion.

Note: You cannot delete a Custom field if it is referenced by 
another equation. The referencing equation must be deleted or 
modified first.

Format Button
Click on this button to bring up a window allowing the formatting of the selected 
field. Specify the total number of digits and decimal places for the overall width of 
the field.

For fields that may result in very large or very small numbers, you may choose 
Scientific Notation as shown in the following examples:

Examples:3.123e+006 is equivalent to 3.123 x 106 (3,123,000)
3.123e-003 is equivalent to 3.123 x 10-3 (0.003123)
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Equation... Button
Click on this button to create an equation associated with the selected Custom 
field (see the note above under Delete Button). The following window will appear:

Figure 7-7 Equation Window

Reference:Reiterates the value of another field, either for convenience of 
repeating the value or custom naming of the field.

Operands:You can enter a constant value or choose any valid report field for 
these values.

Operators:You can choose any of the mathematical operations available on the 
drop down lists. These include common logarithm, natural anti-logarithm and 
square-root for the unary (single operand) operators and addition, subtraction, 
multiplication and division for the binary (two operands) operators.
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Report Output
The Report Output tab offers options for how the report is output.

Figure 7-8 Report Output Window.

Major options offered in the Report Output window are printing the output to a 
printer, saving the output to a file, outputting the report to the RS-232 serial port, 
and tandem processing (running a program and a file after each batch, cycle, or 
sample).

Note:QuantaSmart automatically saves data as dated Results files 
for the optional Replay feature. However you can select other 
formats as reports, including Delimited Text (ASCII), Excel format, 
and Lotus 1-2-3 format.
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Special Files
The Special Files window allows you to select and configure information regarding 
files pertinent to the assays.

Figure 7-9 Special Files

Some of the major selections are making the following types of files:

Composite spectra file
Individual spectrum file
IPA data file
Prot.dat file
2000CA.dat file
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Once you have defined the assay parameters click the OK button in the Assay 
Definition window. Save the file to an appropriate folder, giving the file a 
descriptive name. Once you have saved the assay parameters, you must associate 
the assay to a protocol flag number, load the cassette with vials, load the 
instrument with cassettes, and begin counting the samples.
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Chapter 8

Defining a DPM Assay 
This chapter of the Getting Started manual describes the process for defining a 
single-label DPM assay. Information pertaining to Count Modes and Count 
Correction features is not addressed in this chapter. For detailed information 
regarding these features, and dual or triple label DPM assays, please refer to the 
corresponding topics in the online help documentation.

Note: Single, dual, and triple label DPM assays are options on the TriCarb 2800TR.

The DPM Assay
The DPM assay allows you to quantitate a nuclide or nuclides within a sample in 
defined counting regions. The data generated from the assay is expressed as DPM 
(Disintegrations Per Minute). When DPM are calculated, the level of sample 
quench must be measured. If the sample data is not corrected for the effects of 
quench, erroneous DPM results may be reported.

For each sample in a DPM assay, the instrument:

Measures the activity in a sample vial in Counts Per Minute (CPM).
Determines the level of quench via one of the Quench Indicating Parameters 
(QIPs).
Interpolates the counting efficiency from a quench curve (plots% Efficiency 
vs. QIP).
Calculates DPM, where DPM=CPM/Efficiency.

Prior to defining a DPM assay:

1. The instrument should be calibrated. 

2. A Quench Standards assay must be performed so that counting efficiency and 
DPM can be determined for the samples. 
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Selecting a DPM Assay
Before defining a DPM assay, you must create a new assay by selecting New 
Assay from the File menu. The Select Assay Type window is displayed.

Figure 8-1The Select Assay Type Window.

Select DPM (Single) from the Select Assay Type window and click OK. The Assay 
Definition window is displayed.

Note: For information regarding other assay types, please refer to 
the online help documentation for the QuantaSmart program.
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The Assay Definition Window
Assays are defined by entering information into the seven Assay Definition tabs 
within the Assay Definition window: Assay Parameters, Count Conditions, Count 
Corrections, Report Definition, Report Output, Special Files and Worklist. Using 
these seven tabs, for each DPM assay that you define, you will:

Enter descriptive information about the nature of the assay and specify an 
author of the assay.
Define a sample nuclide in the sample nuclides library if one does not already 
exist.
Link the nuclide to the assay.
Link quench standards to a sample nuclide name in the Sample Nuclides 
Library.
Specify the appropriate count conditions and count correction factors that the 
instrument will use to analyze the samples.
Define the reports you would like the system to generate. 
Define an optional worklist to designate Positive Identification numbers and 
sample names that correspond to sample numbers on a printout, if desired. 
Refer to the online help documentation for details regarding Worklists.

The parameters defined within the context of these seven tabs can be saved and 
used or edited at your discretion. 
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Assay Parameters
The Assay Parameters tab allows you to designate an author and provide 
descriptive information for an assay. You may also prohibit the editing of assay 
parameters using this window. 

Figure 8-2 The Assay Parameters Tab.

Password
Enter a password (optional) to restrict editing functions for this assay. You must 
check the Lock Assay box before you can enter a password in this field.

Lock Assay
Mark this box if you would like to restrict editing functions for this assay. You must 
enter a password in the Password field if you would like to lock the assay.

Author
Enter your name or other identification as the author of the assay. This is an 
optional entry.
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Assay Description
Enter descriptive information about the assay. This information is for future 
reference and is stored permanently with the assay.

Note: For information regarding the individual assay parameters, 
please refer to the “Assay Parameters” topic in the online help 
documentation.

Count Conditions
The Count Conditions tab allows you to define specific counting parameters for an 
assay.

Figure 8-3 The Count Conditions Tab.
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Name
Click this button to display the Sample Nuclides Library window.

Figure 8-4 The Sample Nuclides Library Window.

Note: The window above has been compressed for display 
purposes.
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This window allows you to enter information into and retrieve information from 
the Sample Nuclides Library. You can use the Sample Nuclides Library to define 
and save nuclide names and counting region limits for radionuclides in your 
samples. You can also select a quench set for each sample nuclide using the 
Quench Set buttons in this window.

Select a quench set by clicking one or more of the quench set buttons. Select the 
Low Quench to count one nuclide in one counting region. The medium set would 
be selected for counting two nuclides in two counting regions and the high set for 
counting three nuclides in three counting regions. The Quench Standards Library 
window is displayed. 

Figure 8-5 The Quench Standards Library Window.

Select the name of the quench standards you would like to use for calculating 
DPM values and click OK. The names of any quench sets selected should appear 
on the Quench Set buttons in the Sample Nuclides Library window. The Quench 
Set name also appears in the Quench Set field of the Count Conditions tab in the 
Assay Definition window.

Click OK in the Sample Nuclides Library Window. 
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Quench Indicator
Select a Quench Indicating Parameter from the drop-down list. There are three 
different Quench Indicating Parameters used by the system:

tSIE (transformed Spectral Index of External standards) uses an external Barium-
133 standard source to assign a numeric value to sample quench. This 
determination is independent of the quantity of radioactivity in the sample and its 
count rate. The lower the tSIE value, the more the sample is being quenched. A 
tSIE value of 1000 represents a completely unquenched sample. Accurate DPM 
values can be determined for samples with tSIE values as low as 10. To ensure 
good count statistics, the external standard is typically counted to a 0.5% two 
sigma counting error, where the gross counts equal 160,000.   tSIE is the most 
accurate of the quench indicator options and is typically used for low count rate 
and variable quench samples. 

With tSIE/AEC(transformed Spectral Index of External standards coupled to 
Automatic Efficiency Correction), tSIE assigns a numeric value to sample quench. 
As quench varies, the AEC automatically monitors and adjusts the counting 
regions to exclude unwanted background. This setting is typically used for dual-
label experiments and variable quench samples where optimal region settings are 
desired.

SIS (Spectral Index of the Sample) assigns a numeric value to sample quench. 
The SIS is determined from the spectral shape of the sample and is based on 
actual sample counts. The SIS setting is typically used to monitor the quench level 
in samples for CPM assays or in single label Cerenkov counting.

Assay Count Cycles
Enter the number of times you would like the assay to count. The assay is 
recounted after it has moved one complete cycle around the sample changer 
deck. Any other samples on the sample changer deck will be counted prior to your 
samples being recounted.

Count Time
Enter the maximum length of time that the samples will be counted. Typically, a 
longer count time provides better count statistics. Two other count terminators, 2 
Sigma% and Low Count Reject (LCR), allow you to terminate counting based on a 
preset statistical accuracy or an activity level.
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Background Subtract
Mark this box to subtract background CPM from all samples. The background 
value is established in one of three ways. The method used is selected from the 
drop down list:

When the 1st Vial background subtraction method is implemented, the instrument 
counts the first vial in the protocol for either ten minutes or the defined protocol 
count time (whichever is greater) and establishes a CPM value for each region; 
these are the background values subtracted from each sample within each region 
of the assay.

When the IPA background subtraction method is implemented, the instrument 
subtracts the background values established during the Instrument Performance 
Assessment (IPA) procedures from the entire spectrum of each sample. The 
background spectra are stored during these procedures and are available for any 
counting region.

The Manual background subtraction feature allows you to enter the CPM values 
you would like the instrument to subtract from the entire spectrum of the 
samples.

Note: For information regarding additional items in the Count 
Conditions tab, please refer to the “Count Conditions” topic in the 
online help documentation.
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Count Corrections
The Count Corrections tab allows you to activate certain instrument devices and 
define count correction parameters.

Figure 8-6 The Count Corrections Tab.

Static Controller
The instrument’s static-controlling device, which is designed to reduce static 
originating on the sample vial, is automatically enabled. Static discharge can 
falsely elevate sample counts by producing non-beta pulses. This device should be 
activated in most cases. It is especially important in low humidity conditions, 
when using plastic vials and when handling vials with latex gloves. To further 
reduce the likelihood of generating static:

Maintain a relative humidity level above 40%.
Wipe latex gloves with anti-static wipes before handling vials.
Use the “Pre-count delay” timer which delays the counting of each sample 
while static-induced pulses dissipate.
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Luminescence Correction
Mark this box to activate luminescence correction. The instrument corrects the 
data for counts resulting from sample luminescence.

Apply Half-life Correction
Mark this box to activate half-life correction. This feature is typically used when 
counting short half-life nuclides. The instrument corrects the sample counts for 
half-life decay of the nuclide(s) being counted. The Half-life value for the nuclide 
is taken from the nuclide entry in the Sample Nuclide Library. The Reference Date 
and Time are used to make the decay calculation. The default settings for the 
Reference Date and Time correspond to the start of an assay.

Note: For information regarding additional count correction 
features, please refer to the topic “Count Corrections” in the online 
help documentation.
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Report Definition
The Report Definition tab allows you to specify the data items that are reported 
and the format for reporting. Multiple reports can be defined for each assay.

Figure 8-7 The Report Definition Tab.

Report Name
The Report Name field allows you to assign a descriptive name to a report. You 
can use the four buttons beside the Report Name list to add a new report, remove 
a named report, rename an existing report or reset the field selections to the 
original factory default.

Note: You cannot use special characters when naming reports.
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Report Fields
You may define several printed or electronic reports for each assay, each 
containing different data items. The Report Fields box contains a comprehensive 
list of the available data items. To select the data items you would like to include 
in a report, double-click on those items in the Report Fields box.

Add Button
Click on this button to add a Custom report field to those already available in the 
list of fields. You can define these custom fields for name, content and format as 
desired.

Delete Button
Click on this button to delete a Custom report field from the currently selected 
report. A confirmation window will prompt you to confirm the deletion.

Note: You cannot delete a Custom field if it is referenced by 
another equation. The referencing equation must be deleted or 
modified first.

Format Button
Click on this button to bring up a window allowing the formatting of the selected 
field. Specify the total number of digits for the overall width of the field, including 
decimal space, integer space and the padding (spaces inserted in front of the 
value) necessary to fill any unused space. The decimal point (if appropriate) is 
NOT counted as a digit for this purpose.

The number of digits to the right of the decimal point can also be defined in the 
same manner. Click OK to save any changes.

For fields that may result in very large or very small numbers, you may choose 
Scientific Notation as shown in the following examples:

Examples:3.123e+006 is equivalent to 3.123 x 106 (3,123,000)
3.123e-003 is equivalent to 3.123 x 10-3 (0.003123)
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Equation... Button
Click on this button to create an equation associated with the selected Custom 
field (see the note above under Delete Button). The following window will appear:

Figure 8-8 Equation Window

Reference:Reiterates the value of another field, either for convenience of 
repeating the value or custom naming of the field.

Operands:You can enter a constant value or choose any valid report field for 
these values.

Operators:You can choose any of the mathematical operations available on the 
drop down lists. These include common logarithm, natural anti-logarithm and 
square-root for the unary (single operand) operators and addition, subtraction, 
multiplication and division for the binary (two operands) operators.

Note: For additional information regarding reports, please refer to 
the online help documentation.
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Report Output
The Report Output tab offers options for how the report is output.

Figure 8-9 Report Output Window.

Major options offered in the Report Output window are printing the output to a 
printer, saving the output to a file, outputting the report to the RS-232 serial port, 
and tandem processing (running a program and a file after each batch, cycle, or 
sample). 

Note:QuantaSmart automatically saves data as dated Results files. 
However you can select other formats as reports, including 
Delimited Text (ASCII), Excel format, and Lotus 1-2-3 format.
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Special Files
The Special Files window allows you to select and configure information regarding 
files pertinent to the assays.

Figure 8-10 Special Files

Some of the major selections are making the following types of files:

Composite spectra file
individual spectrum file
IPA data file
Prot.dat file
2000CA.dat file
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Once you have defined the assay parameters click the OK button in the Assay 
Definition window. Save the file to an appropriate folder, giving the file a 
descriptive name. Once you have saved the assay parameters, you must associate 
the assay to a protocol flag number, load the cassette with vials, load the 
instrument with cassettes, and begin counting the samples.
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